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How to use Movie Maker 2
These notes have been produced to assist teachers and students wishing to create their own movies and perhaps use images, sounds and video clips from the E2BN Myths and Legends site, British Pathe film archive, the E2BN Gallery and Audio Network. 

Please note, the British Pathe film archive and the Audio Network archive is only freely available to all schools and any other establishments which access Broadband via the National Education Network via their local Regional Broadband Consortium (RBC).  Resources on the Myths and Legends site are freely available for use by all schools.
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1.
Windows Movie Maker - Overview:                                                                                    

Windows Movie Maker – what is it?
Windows Movie Maker is a piece of software which can be used to capture video and audio to your computer from a video camera, web camera, or other video source, and then use the captured content in your movies. You can also import existing audio, video, or still pictures into Windows Movie Maker to use in the movies you create. After editing the audio and video content in Windows Movie Maker, which can include adding titles, video transitions, or effects, you can then save your final movie and share it with others.

When I have made a movie what can I do with it?
You can do a whole range of things with your finished movie – if you have a DV camcorder, you may be able to copy it back to DV tape, or you can save it in a format which can be emailed to other people. If you have a CD burner, you can burn your movie on to a CD-Rom. Or you can simply save it onto the hard disk of your computer.
2.
Hardware & Software Requirements:                                                                                    

What do I need to make movies with Movie Maker?

· A computer running Windows XP (the software is available for Windows ME but it is the early version of Movie Maker and it is not possible to upgrade it. It does not come with earlier versions of Windows).
· The latest version of Windows Movie Maker (currently version 2.0 as of April 2004) - get it here.
· A digital camera to capture still images (or a scanner to scan hard-copy images).
· A digital camcorder if you wish to include video in your movies.
· A firewire connection in your camcorder - some PCs and laptops now come with this built in but, if not, it can be added for less than £50.
· It’s not essential, but you might need something to edit audio (e.g. for background music) – you could use Goldwave, which is a shareware programme available from www.goldwave.com.
3. 
Software Versions:                                                                                    

I may not have the latest version of Movie Maker – what can I do?
The latest version of Movie Maker is version 2 - how can you tell if you have the right one? It's quite simple:

1. Open Windows Movie Maker by double-clicking its icon or by selecting it from the Programs list. 

2. When it has opened, go to the Help menu and select About Windows Movie Maker. 

3. You should see a window like the one below. 
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If you have an earlier version, then go to this site and download the latest version. When you have done this, double-click the file you downloaded and this will install Movie Maker. 
4. 
The Windows Movie Maker Interface:                                                                                    

When you open Windows Movie Maker you will see something similar to the screenshot below (it may not be exactly like this as it depends on how other users have previously used it).
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5. Storyboard or Timeline:   
The Storyboard/Timeline area is where your movie will be assembled. There are two different modes for this area – either can be used and individuals will discover for themselves which of the two they prefer. The Storyboard is much simpler than the Timeline.
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Storyboard Mode
The storyboard mode is very simple in layout – video clips or still images are dragged to the storyboard, and added at the next available empty slot. Video Transitions (more on these later) are added to the smaller slots between the larger ones.
Timeline Mode
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The Timeline mode is more complex and displays individual video and audio tracks – overlay titles are added to the Title Overlay track and music to the Audio/Music track and so on. Certain actions can only be carried out in Timeline mode. For example you can only add music or narrate the timeline in that mode. If you are in Storyboard mode, Movie Maker will automatically switch you into Timeline mode.
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The screenshots below show what the same assembled movie looks like in each of the two modes.

Here is the Storyboard view

Here is the Timeline view
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When you need to preview a clip or your movie then you can do this by viewing it in the Monitor window. Use the controls below the Monitor to play/pause/stop the clip. As well as the first button, which will start and pause playback, there are other control buttons too.
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The other buttons, in order:

1. Move the playback to the start of the previous clip 

2. Move the playback head back one single frame 

3. Move the playback head forward one single frame 

4. Move the playback to the start of the next clip

6. 
Capturing Video from a Camcorder:   
If you wish to capture video, which you have shot with your camcorder you will need to do the following:

1. 
Connect your camcorder to your PC using the Firewire cable (also called IEEE1394 cable)

2. 
Open Windows Movie Maker

3. 
In the Movie Tasks pane click ‘Capture from video device’ or go to File and click ‘Capture Video’

4.
In the next window give your clip a name and choose where to store it

5. 
In the next window select the quality at which you wish to capture

You can then capture further clips to your computer.

7. 
Importing an Existing Video Clip:   
Using Windows Movie Maker you can create your own films by using existing video clips which you captured previously or which were obtained from other sources, e.g. the British Pathe Film Archive (www.britishpathe.com)

Movie Maker will import the following video file formats:
Video files: .asf, .avi, .m1v, .mp2, .mp2v, .mpe, .mpeg, .mpg, .mpv2, .wm, and .wmv

The clips in the British Pathe archive are currently available in Windows Media Video (wmv) format.

First of all, to import a piece of video e.g. a Windows Media Video (wmv) file, click on Import Video in the Task pane.
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In the Import File window select the file you wish to use and click Import.
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Movie Maker will now import the video file – it will usually import it as a number of clips as it is able to spot different sections of video. This is very useful and makes the whole thing much easier to edit. 

In the example below, I imported a wmv file called ‘pirate radio ’ which Movie Maker displays as eight separate clips.

[image: image6.png]otiecuon: pirate: ramio;

D19 lp and diopi o th stopboard below:

- Capture Video

Capturefrom video dice
ingort vdeo

Inport itures

Inport sudo o music

. Edit Movie @ pirae rado 002

Viow vicko effects
View vidotranstons
ke ttesor credts
Make an Autobovie

. Finish Movie

S —— prate rado 004 prae rado 005 praterada 006

SevetaCh
Send in sl




8. 
Importing Images:   
Movie Maker also allows the import of images, which can be used in the creation of movies. Movie Maker supports the following picture file formats:
Picture files: .bmp, .dib, .emf, .gif, .jfif, .jpe, .jpeg, .jpg, .png, .tif, .tiff, and .wmf 
Click on Import pictures and select the picture(s) to be imported. If you wish to import more than one picture then hold down ‘Ctrl’ and single-click on each picture in turn, then click on Import. The images will then be displayed in Movie Maker.
9. 
Importing Sounds:   
You can import sounds into Movie Maker in just the same way. The following sound file formats are supported:
Audio files: .aif, .aifc, .aiff .asf, .au, .mp2, .mp3, .mpa, .snd, .wav, and .wma
Click on ‘Import audio or music’ and select the sound files to be imported. 

Note that you cannot edit the sound (apart from its overall length and volume) in Movie Maker. If you wish to edit the sound before you add it to your movie then you will need to use an audio-editing package. A good choice is Goldwave, which is a piece of shareware and is available to download from www.goldwave.com.

Goldwave will allow you to edit the sound in many different ways - alter the speed, the pitch, add echo, add a whole range of other effects.
10. 
Grabbing Still Images:   
Windows Movie Maker includes a tool, which allows you to 'grab' individual frames from a movie clip and save them as still images. This is very useful indeed. The 'grabbed' images can be used as part of the movie or could be used in other applications e.g. in Word, Publisher, PowerPoint etc.

An activity I have used with students is to ask them to watch, say, a 5-minute video clip and identify the key moments of the film. I then ask them to select a maximum of 20 still images, which will still tell the story of the film. More challenging than it might sound!

To grab a still image:

1. Import your video clip as described previously - it will be imported, probably as a number of individual clips 

2. Click on any one of the clips and click on the 'Play' button in the monitor window 

3. When you see a section containing the image you want to grab, press the 'Pause' button to hold the image still - now use the 'previous frame' and 'next frame' buttons to view the exact frame you want to grab. 

4. In the bottom right corner of the monitor window you will see a small icon looking like a camera 

5. Click this icon - the frame will be grabbed and a fairly standard box will open up asking you to give the image a name and to choose a location for it. 

6. The image has now been saved as a separate file. It will also appear in your 'collections' window, allowing you to use it straight away, in your movie, if you wish. 

7. If you wish to grab more stills repeat steps 2 – 6
11. 
Grabbing Still Images:   
Right Then, Let’s Make A Movie!
Once you have imported your video files, pictures and any audio files you wish to use, you are ready to assemble them to make your own movie.
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For this example we will start by working in Storyboard mode and then use the Timeline mode for some of the later work. So, make sure you are in Storyboard view – the lower part of the Movie Maker window should look like this:

We will begin by adding some video clips to the storyboard.

Select the clip you wish to use by clicking on it once – if you wish to preview it before adding it to the Storyboard then click the Play button in the Monitor window. You should now see that clip play. Assuming it is the one you wish to use, add it to the storyboard by dragging it to the first vacant space.

Add further clips in the same way – your storyboard may then resemble the one below:

If, at this point, you would like to see how your movie is shaping up, then click on the first clip on the storyboard and click play in the monitor window – you should see the whole movie play, not just the first clip. You might like to see your movie at a larger size – go to the View menu and click ‘Full Screen’ to see it at full screen size. You can also click on the small icon above the 'Play' button.
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To return to normal view, hit your ‘Esc’ key.

REMEMBER TO ‘SAVE’ YOUR MOVIE FREQUENTLY
12. 
Transitions:   
Rather than have straightforward cuts between your individual clips, you may prefer to make use of some transitions. A transition is a way of moving from one clip/image to another one, for instance by using a Dissolve, a Fade, a Wipe or a Split.
In the Movie Maker storyboard transitions are placed on the smaller space between the two clips. When in “Timeline view” the transitions appear on their own track below the video track.
You can access them by clicking on ‘View video transitions’. 
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Clicking on this will display the available transitions (additional ones can occasionally be downloaded from the Windows Movie Maker website).

[image: image9.png]



To add a transition to your movie drag the one you want to use to a space between two clips, as below.
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Add further transitions between your other clips if you wish to use them. 

Don’t use transitions for the sake of it – they should be used for a purpose. In general try to stick to simple transitions e.g. Fade and Dissolve, keeping the more unusual ones for 'special' occasions!
13. 
More on the Timeline View:   
Once you are ready to move to more complex editing, for instance adding titles and effects, you will find it easier to see what is happening if you are working in Timeline view, rather than Storyboard. To change to Timeline view click on ‘Show Timeline’ just above the Storyboard area.

Instead of seeing one single track as you do in Storyboard, you will see five separate tracks.


From top to bottom the five tracks are:

Video - video captured from your camera or from an imported clip
Transition - transitions from clip to clip appear here
Audio - the audio from your captured/imported clip
Audio/Music - additional audio/music/narration added here
Title Overlay - titles displayed as overlays are shown here

You will see that there is a precise timecode at the top of the timeline, which allows you to keep a close eye on the length of your movie or individual elements. As your movie plays in the mode, you will see a blue line, with a handle at the top, moving across the Timeline. This time-marker can be grabbed with your mouse and dragged back and forth along the Timeline to a particular position. Dragging this marker along the Timeline is known as 'scrubbing'.

You are given much more control of objects in Timeline view – you can click and drag objects along the Timeline to precise points, you can lengthen a transition or other object by placing your cursor at one end of a clip and dragging to make its duration longer or shorter.

If you need to see your Timeline in more detail then you can zoom in (and out). Go to the View menu and select an option or alternatively use the + and - zoom buttons at the top-left of the Timeline.
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In the same location just to the right, you will find two buttons that allow you to rewind and play the timeline.

[image: image12.png]



14. 
More on the Timeline View:   
You can add a real touch of professionalism to your movie by adding opening titles, end credits, overlay titles and even subtitles etc
To add titles click on the ‘Make titles or credits’ item in the task pane.
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This will take you to the following screen.
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From this you can select where you wish to place your titles. For example we could choose to add a title to the beginning of the movie by clicking ‘Add title at the beginning of the movie’. This would then take you to the screen shown below where you can enter the required text.
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If you are happy with your title you can simply click, ‘Done, add title to movie’.
However, below the text area are further options to change the font, colour etc and to change the way the title is animated.
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First of all, let’s look at changing the title animation.
This option will let you introduce your title in a more dynamic way, for instance, by having it fly in or scroll up.
Click on ‘Change the title animation’ and you will see the following screen:
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Click on any of the choices in the list which appears and you will see an example in the monitor window of how that animation would work.
When you are happy with your choice then click ‘Done, add title to the movie’.

Secondly, you can edit the appearance of the title text, by selecting ‘Change the text font and colour’. This brings you to a screen like the one below.
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Here you can select a different font and font size, font colour, background colour, alignment and a level of transparency. Make your choices and then click ‘Done, add title to movie’.


Your title should now appear at the start of your movie.
Making end credits is done in the same way, but at the start of the process choose ‘Add credits at the end of the movie’.

If you wish to add titles at a specific point in your movie then use an option such as, ‘Add title before the selected clip’ or ‘Add title on the selected clip’ if you wish the title to be overlaid on top of your clip (e.g. as a subtitle).
If you add overlay titles to your movie, and if you are in Timeline view, you will see the titles added to the Title Overlay track at the bottom of the Timeline.

REMEMBER TO ‘SAVE’ YOUR MOVIE FREQUENTLY
15. 
Video Effects:   
Movie Maker comes with a set of video effects which will let you change the appearance of your movie clip so that, for instance, you could make a modern piece of video footage look much older, you could make a piece of coloured film appear as black and white, you could speed up or slow down some film or you might make a clip brighter. You could, for instance, take a Pathe clip of an historical event such as “The Jarrow March” and edit into it an 'interview' (shot with your school camcorder) with one of the marchers. The modern clip can then be added into the older film and an ageing effect applied to make it look like part of the original film.

To add effects, choose ‘View video effects’ from the task pane. 
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This will display the available video effects, as below:
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To add a video effect, simply drag the effect on to the clip you wish it to be applied to. A star appears on the video clip or picture that you applied the effect to on the Video track.
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You should note that certain effects have some unusual effects on the clips they are applied to. For instance, adding the ‘slow down’ effect to a clip will also slow down the audio track. 


Video effects are maintained when you split (more on that in a moment), cut, copy, or move a video clip or picture. For example, if you add the Gray Scale video effect, and then split the clip, the Gray Scale video effect is applied to both clips. However, if you combine two video clips, the video effects that were associated with the first clip are applied to the new combined clip, and the video effects that were associated with the second clip are removed.

Removing A Video Effect
1. 
Select the video clip or picture in the storyboard/timeline that you want to remove a video effect from. 

2. 
On the Clip menu, point to Video, and then click Video effects. 
3. 
In the Displayed effects area, click the effect you want to remove, and then click Remove. 

Alternatively, right-click on the clip which contains the effect and from the pop-up menu select Video Effects.
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16. 
Splitting Clips:   
Whilst you are applying effects in Movie Maker, or if you wish to remove part of a clip, or if you wish to copy only part of a clip, or to do a whole host of other things, you may need to be able to split an existing clip into one or more pieces. To do this, first select the clip by clicking on it in the Timeline. 

Just below the Monitor window you will see two small buttons – if you hover your mouse over the one on the left it will tell you that it can ‘Split the clip into two clips at the current frame’.
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In other words wherever your playback head is, that is where the split will be made

Place the playback head at the desired frame and click this button – the clip will now be split into two, and each of the two pieces can be treated independently of each other. 

Movie Maker has a rather limited, though still useful, approach to working with audio. Basically, Movie Maker allows you to have 2 pieces of Audio in your movie, though there is a way to get more.

The first piece of audio will appear on the ‘Audio’ track and this track is reserved for the audio, which was captured by the camera or imported as part of the video clip. As you add a video clip to your movie the audio will automatically be placed on this track. If you are placing only still images on the Video track, the Audio track will simply remain empty. However, it cannot be used to place, for instance, a music track.
17. 
Working with Audio –Video track, Music, Voice-over:   
The second track, called ‘Audio/Music’ can be used for a number of purposes:

1. Adding sound effects (usually wav or mp3 files)

2. Adding music (usually wav or mp3 files)

3. Adding narration or voice-over

You can import sound effects and music files very easily, by clicking in the task pane on the ‘Import audio or music’ button.
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Clicking on this will open the ‘Import audio’ window, where you can select a file to use – this will usually be a wav or mp3 file but Movie Maker will accept many other file formats too.
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Having imported the audio file, it will appear in the collections pane. 

[image: image26.jpg]Collection: pirate radio
D1 cip v 09 o th el b,

-

prateato0nl  aneiconbesty-pats  pratersdoosz
b ] et




From here it can be dragged onto the Timeline and moved to the exact position you want it to start playing.

Alternatively, right-click on the audio object and select ‘Add to Timeline’ and then move it into its precise position.

Note, that if you try to add the audio whilst in Storyboard view, Movie Maker will automatically change to Timeline view and will display a message telling you that it has done this.

Remember that adding copyright music to your movie is a breach of copyright law and that if you intend to publish your movie on a CD or on the web, you could find yourself in considerable trouble. Music publishing companies are clamping down on the illegal use of copyrighted music and you and your students need to be aware of this.

There are sources of copyright-free and royalty-free music available. You can purchase collections of copyright-free music from many organisations. For instance:

Trackline Music
AKM Music
NVM Digital Music
However they are not cheap (average price around £30 per CD). A source of free music is available at Freeplay Music - it is generally of good quality and pieces of music can be downloaded at different lengths. So, if you only require a 30 second piece you can have that, but longer/shorter versions of the same track are usually available too. If you are a school and are using it for non-commercial use then there is no fee to pay for its use.

Adding Voice-Over
Including a narration or voice-over in your movie is very easy. Movie Maker includes a tool to do just that. At the left-hand end of the timeline are two small buttons, which are: 

	Set Audio Levels
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	Narrate Timeline
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To record a voice-over, do the following:
Click on the ‘Narrate Timeline’ button, which will bring up the following screen:
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Having connected your microphone, if it is not already connected, test it by speaking into it - you should see the audio meter respond. If it does not:

1. Check the microphone connection is properly in place

2. Click the text which says, 'Show more options' - check that the 'Audio Input source' drop-down box is set to 'Microphone'
3. If it still does not work make sure that the recording volume level is set high enough by adjusting the slider on the 'audio input level'

4. If this is still not successful try a different microphone if possible


Set your playback head at the point on the timeline where you want the narration to begin – this must be a place where the Audio/Music track is empty.


Click on the Start Narration button – you will see your movie playing in the monitor window – speak your voice-over. When you have finished click on ‘Stop Narration’.


Make sure that the Input level is high enough – if it is not, then adjust it so that the sound recording level goes into the yellow zone but not the red (too loud).

REMEMBER TO ‘SAVE’ YOUR MOVIE FREQUENTLY
Adjusting Audio Levels
Having added audio to your movie, you will almost certainly need to adjust the sound levels of your two tracks. There are a number of ways to do this.
The simplest way to adjust the balance between your Audio track and your Audio/Music track is to use the Set Audio Level tool. Click on the button, or in the Tools menu select Audio level.
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Simply slide the slider towards the right to adjust the balance in favour of the Audio/Music track and to the left to let the Audio from video become dominant.

However, you can also adjust the volume of individual clips and you can fade in/out.
To fade in a piece of audio, select the clip by clicking once on the clip and then from the Clip menu select Audio or you can right-click on the clip and select Fade In.
A Fade out is done in the same way.

Clips can be muted completely by selecting the Clip menu and choosing Audio – Mute or by right-clicking and selecting Mute.
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To change the volume setting for a clip, choose Clip – Audio –Volume. This brings up a Volume control, which you can adjust as needed.
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Remember that doing this changes the volume of the whole clip to the new setting. What if you want part of your clip to be louder than another part? Well, you need to split your clip (see previous section) and then apply different volume settings to the separate sections.

18. 
Need another audio track? Here’s how!:   
Okay, So Have You Spotted The Problem Yet?
That’s right, you cannot have a music soundtrack and a voice-over in your movie – it looks like you can only have one or the other. There is only one Audio/music track and you cannot add both things to it and make them play simultaneously. This is a major drawback of this software or, at least, it could be if we hadn’t been clever enough to spot a way to make it work.

Here’s how it can be done!
This process involves a number of stages and may appear a little complicated (it's not really!).

Step 1 – make your movie and add your voice-over
Step 2 – produce your movie as a final movie file (export)
Step 3 – start a new project and import your finished movie back into Movie Maker
Step 4 – add your background music onto the now empty track
Step 5 – produce your movie as a final movie file again.

We will now go through that process in more detail.

Step 1 - make your movie and add your voice-over
Okay, so we know how to do this bit now and there’s no need to go over the whole thing again. If unsure, go back over the previous sections.

Step 2 - produce your movie as a final movie file
We will go over this in more detail in later sections but for now, follow these instructions.
When you are ready to do this bit, click on ‘Save to my computer’ in the task pane.
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This will open up the following window:
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Give your movie a filename and choose a place to save it to – you can just accept the one it suggests, if you wish. Then click Next. Click Next again in the next window (more on those settings later). Your movie will then be rendered to produce a final movie file.

When it is finished, leave the tick in the box against ‘Play movie when I click Finish’– then click Finish to see how it turned out. It will probably open in Windows Media Player - you will need an up-to-date version of WMP to play your files - if you need to upgrade your media player click here. 

Step 3 – start a new project and import your movie back into Movie Maker
Now, back in Movie Maker, start a new project – go to File and New Project.

Now, as described before, import your previously made movie back into Movie Maker – go to ‘Import video’, browse to the file and click Import. The movie may come in as a series of consecutively numbered clips. This is not a problem - simply drag them back onto the Timeline in order. 

You will see that the Audio/Music track is now empty! So…..
Step 4 – add your chosen background music onto the now empty track (as described earlier)

Step 5 – produce your movie as a final movie file again.
Repeat step 2 and hey, presto! A movie, complete with music and voice-over.

You should note however that getting the balance right between the music track and the narration can be quite tricky and may take more than one attempt, so please be patient. My advice would be usually to add the narration first, export it, import it and then add the music.
19. 
Exporting your movie:
Once your project is complete, you can output your final movie in a number of different formats for different purposes. Under the ‘Finish Movie’ area of the Task pane you can select one of five different choices.

The following section should make clear the options, which are available to you:

Option 1 - Save to My Computer
The My computer saving option lets you save your movie for playback on your local computer. When you select this option, the final movie is stored in the specified location on your computer or on a shared network location. The file is saved as a Windows Media Video (wmv) file, which can then be played back in Windows Media Player.
If you select this option you will need to run through a number of stages in the wizard, which require you to:
1. 
Specify a movie file name and place for your movie to be saved. 

2.
Choose a movie setting for saving your movie. 

3. 
Wait for your movie to be saved. 

4. 
Complete the Save Movie Wizard. 

At step 1 give your file a name and select a place to save it – by default it will probably save it to ‘My Videos’ on your hard disk.
At step 2 you can accept the chosen setting of ‘Best quality playback for my computer’ or you can see more choices, in which case you will need to select a quality setting from the drop-down menu

You need to be aware that the final file size will depend very much on the setting you choose here. As an illustration, my movie is shown in the table below saved at various bit rates.

	Chosen bit rate
	Resulting file size

	Video for dial-up access (38kbps)
	605kb

	Video for ISDN (48kbps)
	726kb

	Video for Broadband (512kbps)
	7.8mb

	Video for local playback (2.1mbps)
	31.22mb


Obviously the higher the chosen bit rate, the better the quality of the resulting file will be but, also, the bigger the file will be. If file size is not a problem for you and you do not need to carry it around on a floppy disk, then go for the best quality you can. However, you should also know that some PCs with much slower processors/disks may have difficulty playing a high quality piece of video and you will see the playback stutter and jerk rather than playing smoothly.

Having selected the quality at which you wish to save your movie, click Next. You now need to wait for your movie to be saved. The time taken varies very much depending on the size of the movie, how many tracks have been used, the bit rate you have chosen and the speed of your PC processor. As an illustration, my movie, which was approx one and a half minutes long and was saved at a low bit rate (ISDN quality), took about 5 minutes to render. However a 20 minute movie, using all tracks and saved at local playback quality could take anything up to 2-3 hours, depending on the speed of your computer.

Option 2 – save to CD
The Recordable CD saving option lets you save your movie for playback on a recordable or rewriteable CD (CD-R or CD-RW). When this option is selected, the final movie is saved to a recordable or rewriteable CD in the Save Movie Wizard.
If you click the Recordable CD option, the Save Movie Wizard proceeds as follows:

1. 
Specify a movie file name and CD name. 

2. 
Choose a setting for saving your movie. 

3. 
Wait for your movie to be saved. 

4. 
Complete the Save Movie Wizard.
At Step 1 you will need to give your movie a filename and also give your CD a name.
Step 2 involves a process identical to that for the ‘My Computer’ option – select a bit rate for your CD movie.
At Step 3 you will need to wait for your movie to be saved and copied to CD, after which the process will be finished at Step 4.
Option 3 – send in email
The E-mail saving option lets you save your movie and then send it as an attachment by using your default e-mail program. When this option is selected, the final movie is saved to a temporary location, and then sent as an e-mail attachment.
If you click the E-mail saving option, the Save Movie Wizard proceeds as follows:

1. 
Wait for your movie to be saved. 

2. 
Complete the Save Movie Wizard. 

Be aware that the resulting file could be quite large and there may be problems sending it by email. Some email systems will not transport attachments larger than a specific size (e.g. Talk21 does not send attachments larger than 1mb) and also be aware that the person receiving the attachment may have to wait a long time for it to download at their end, if they have a slow connection.

Option 4 – sending to the web
The Web saving option lets you save your movie and then send it to a video hosting provider on the Web. The hosting providers are third-party companies that let you store your movies on their Web server. In Windows Movie Maker, you can choose from a variety of hosting providers. After your movie is sent to the Web server, you can provide your family and friends with the Web address so they can watch your movie on the Web.
When using The Web saving option, the Save Movie Wizard proceeds as follows:

1. 
Specify a movie file name. 

2.  
Choose a setting for saving your movie. 

3.   
Wait for your movie to be saved. 

4. 
Wait for the most current video hosting provider information to download from the Web.

5. 
Select a video hosting provider, and then enter your account sign-in information. 

6. 
Wait for your sign in account information to be verified. 

7. 
Wait for your movie to be sent to the video hosting provider that you specified. 

8. 
Complete the Save Movie Wizard. 

Option 5 – Saving to DV Camera
The DV Camera saving option lets you record the movie you create to a tape in a DV camera through Windows Movie Maker. This lets you or others watch the final movie on a DV camera or on TV when you connect the camera to a TV. When you choose this option, the movie is recorded to the tape in your DV camera, so it appears on the tape with existing video you might have already recorded back to tape or recorded with your DV camera.
To record your movie to tape, your DV camera needs to be in the playback mode (often labelled Play, VCR or VTR on your camera). Your camera also needs to be a camera, which has DV In as well as DV Out. See your specific camera for more information on this. Many cameras bought in the last 2-3 years do not have this facility, whilst newer and more expensive ones often do.

If you click the DV Camera saving option, the Save Movie Wizard proceeds as follows:

1. 
If you have more than one DV device connected to your computer and powered on, select the DV device on the DV Camera page that contains the tape that you want to record your movie to. 

2. 
Set your camera to playback mode, and then rewind or fast-forward the tape to the point where you want your movie to be recorded. 

3. 
Wait for your movie to be created and then recorded to tape. 

4. 
Complete the Save Movie Wizard. 

Which option should you select?
That entirely depends on what the movie is going to be used for. If it is intended for the web then it needs to be made in a streaming format, such as Windows Media Video (wmv) and the file size needs to be suitable to the target audience’s likely connection speed. For instance if you know that most of your end users have a dial-up connection, then the bit rate needs to be kept low, whereas a broadband audience can be offered something at a much higher quality.
If the movie is to be played on your own PC or copied to tape, then you can produce at as high a quality as you can.

20. 
Glossary:   
Bit rate:
  The number of bits transferred per second. 

Capture:
  To record audio, video, or still images as data in a file. 

Clip:

  Small segment of a larger video file. 

Compression:
A process for removing redundant data from a digital media file or stream to reduce its size or the bandwidth used. 

Content:
Audio, video, images, text, or any other information that is contained in a digital media file or stream. 

Cross-fade:
  A method of smoothly moving from one video clip or photo to another. 

Frame:
  One of many sequential images that make up video. 

Import:
The process of bringing a resource - video clip, audio clip, sill image - into the editing software.
Split:

  To divide an audio or video clip into two clips. 

Timeline:
The area of the user interface that shows the timing and arrangement  of files or clips that make up a project. 

Trim :
To hide parts of a file or clip without deleting them from the original source. Files and clips can be trimmed by adjusting the start or end trim points. 

Windows Media file :

A file containing audio, video, or script data that is stored in Windows Media Format. Depending on their content and purpose, Windows Media files use a variety of file name extensions, such as: .wma, .wme, . wms, .wmv, .wmx, .wmz, or .wvx.
21. 
Further Help:   
Microsoft Windows Movie Maker Home page - downloads, extra effects, fun packs etc

Microsoft Windows Media Player Home Page - download updates and additional codecs

Windows Movie Maker 2 Review Site
Movie Maker Forum - Tips, discussions, tools and more
Making a montage with Movie Maker
Becta Digital Video Awards 2004
Storyboarding your movie
British Film Institute Education
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